
1 

MINISTRY OF EDUCATION AND SCIENCE OF UKRAINE 

 

KHARKIV NATIONAL UNIVERSITY OF ECONOMICS 

 

 

 

 

 

 

 

 

 

Guidelines to laboratory works  

on the academic discipline  

"STATISTICS" 
for full-time students of training direction 6.030601 "Management"  

of the specialization "Business Administration"  

and of training direction 6.140103 "Tourism" 

 

 

 

 

 

 
 

 

 

 

 

 

 

 
 
 

Харків. Вид. ХНЕУ, 2013 



2 

Затверджено на засіданні кафедри статистики та економічного  

прогнозування. 

Протокол № 13 від 29.05.2013 р. 

 

Compiled by: O. Rayevnyeva 

 I. Serova 

 O. Bobkova 

 O. Gorokhova 

 O. Zirko 

 

 

 

 

 

 

 

 
 
 

G94  Guidelines to laboratory works on the academic discipline "Statistics" 

for full-time students of training direction 6.030601 "Management" of the 

specialization "Business Administration" and of training direction 6.140103 

"Tourism" / compiled by O. Rayevnyeva, I. Serova, O. Bobkova et al. – 

Kh. : Publishing House of KhNUE, 2013. – 60 p. (English) 

 

Laboratory works on the academic discipline and guidelines to their implementation 

are given to help the students acquire the fundamentals of using the methods of the theory 

of statistics for analytical assessment of information in tourism. 

Recommended for students of the specialization "Business Administration". 

 

Наведено лабораторні роботи з навчальної дисципліни та методичні рекомен-

дації до їх виконання, які сприяють засвоєнню студентами основ використання мето-

дів теорії статистики з метою аналітичної оцінки інформації в галузі туризму. 

Рекомендовано для студентів спеціалізації "Бізнес-адміністрування". 

 

 

 

 



3 

Introduction 
 

The implementation of laboratory works is aimed at developing stu-

dents' skills of using statistical methods of analysis of distribution series. The 

laboratory works assume their mastering the fundaments of MS Excel pac-

kage, i.e. building, the automation of conservative calculations and charts the 

incremental implementation of tasks, the essence of statistical methods of 

analysis of distribution series etc. 

While carrying out the laboratory work each student should use a par-

ticular book of Excel (recorded in a separate file). In addition, each task is 

performed on a separate page of the book. In the cell A1 of each sheet the 

number and title of the work should be mentioned. For example: Laboratory 

work No. 1. Overview of Excel. Each page of the book should contain the 

number of the task, e.g. Task 2.3. Each file name should include the name of 

a student and the work title, for example, Ivanov – 3. For each paper the stu-

dent must submit a report that contains the title of the work, and tasks results. 

For questions that are given in the tasks, but do not require calculations and 

constructions, a student must prepare a recitation. 
 

Qualification requirements for the students in the area 

of Statistics 
 

Knowledge base necessary for studying the discipline 
 

In order to better understand the educational material of the academic 

discipline, students must first acquire knowledge and skills in the field of ge-

neral theory of Statistics, Economic and Mathematical Modelling. In turn, the 

knowledge of the studied discipline provide successful performing the pro-

jects by the students. While studying of the academic discipline "Statistics" 

students should acquire the following skills (Table 1.1). 
 

Table 1.1 
 

Competencies to be formed while performing laboratory works  

on "Statistics" 
 

The name of  

а competency 

The content of  

a competency 

The ability of a student in regard to this 

competency 

1 2 3 

1. Accounting and 

statistics 

1.1. The ability to 

conduct statistical 

calculations 

1.1.1. Carrying out the calculation of indicators 

for checking statistical hypotheses. 

1.1.2. Carrying out the calculation of time series 

indicators 
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Table 1.1 (the end) 
 

1 2 3 

2. Analytical 2.1. The ability to 

conduct a statisti-

cal analysis 

2.1.1. Identifying the factors that influence the chan-

ge indicators. 

2.1.2. Forecasting the run of the processes ana-

lyzing and evaluating possible consequences 

of changeable conditions 

3. Organizational 

and methodologi-

cal 

3.1. The ability to 

apply the statistical 

methodology 

 

3.1.1. Own methods of forecasting. 

3.1.2. Own research methods of the types of 

economic and social phenomena. 

3.1.3. Own methods of assessing the general 

trend of phenomenon. 

3.1.4. Own methods of assessing the stochas-

tic phenomena. 

3.1.5. Own methods of forecasting based on 

trend extrapolation models. 

3.1.6. Own methods of vibration and dynamic 

series consistency. 

3.1.7. Own methods of constructing the univa-

riate and multivariate regression models. 

3.1.8. Own methods of constructing the auto-

correlation 

4. Control 4.1. The ability to 

build single-factor 

and multi-factor mo-

dels and check them 

for compliance 

4.1.1. Preparing the information choosing the 

type of models, carrying out the calculations of 

their parameters and checking them for comp-

liance. 

4.1.2. Using the appropriate criteria for ana-

lysis of the level of the authenticity of fore-

casting the estimates 

5. Information 5.1. The ability to 

use modern means 

of information pro-

cessing for solving 

the economic tasks 

5.1.1. Using a variety of features of the Excel 

application package for visualization systems 

analysis of economic processes or phenome-

na in order to enhance the quality of mana-

gement decisions 

 

Laboratory work No. 1 

Overview of Excel 
 

The purpose of this work is acquiring the skills of operating the MS 

Excel spreadsheet. 

Its task is to learn the basics of using a spreadsheet: introduction and 

editing of data formatting, designing tables. 
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Guidelines 
 

The Excel is a program that belongs to the category of spreadsheets 

and is a part of Microsoft Office package. One of the main advantages of 

Excel is its generosity. There are several possible applications of Excel. 

Among them are: 

1) the solution of numeric problems that require time-consuming cal-

culations, such as reporting, analysis of research results, and the use of diffe-

rent methods of financial analysis; 

2) creating charts. Excel contains tools to create different types of charts; 

3) the organization lists. Excel allows you to efficiently create and use 

structured tables, the columns of which contain the similar type of data; 

4) access to the data of other types and the ability to import data from 

many different sources; 

5) creating drawings and charts. Using Excel AutoShapes to create 

simple (and complex) schemes; 

6) automation of complex tasks by means of Excel macros, i.e. one can 

perform the same type of tasks with one click. 
 

Workbook and worksheet 

All the actions performed in Excel, are saved in the workbook, which opens 

in a separate window. By default, the workbook files have the XLS extension. 

Each workbook contains one or more worksheets, each consisting of 

individual cells. The cell can store a number, a formula or a text. To move 

from one worksheet to another, you need to click on the appropriate sheet 

tab, which is located at the bottom of the workbook. Furthermore, a work-

book can contain chart sheets, each of them including one chart. One can go 

to the chart sheet by clicking on its label. 

In Fig. 1.1 the most important elements of Excel window are shown. 
 

 
 

Fig. 1.1. The most important elements of Excel window 
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Moving within the worksheet 

Each worksheet consists of rows (numbered from 1 to 65.536) and 

columns (denoted by the letters A through IV). The column Z is followed by 

the column AA, AZ – by VA, etc. At the intersection of a row and a column 

there is single cell. At the moment, only one cell can be active. The active cell 

has dark contour (Fig. 1.2). 
 

 
 

Fig. 1.2. The active cell 
 

Its address, i.e. the column letter and the row number is specified in the 

Name field. Depending on the chosen method of moving to the workbook the 

active cell can move or remain unchanged. The titles of a row and a column 

at the intersection of which the active cell is are marked by dark colours. 
 

Using the keyboard 

To move within the worksheet, you can use the cursor keys. Pressing 

the "↓" key moves the table's cursor one row lower, pressing the "→" key 

moves one column to the right, etc. 

<Num Lock> button controls the buttons on an additional digital keypad. 

When the Num Lock indicator is on, Excel highlights in the status bar NUM 

label. In this case, the additional digital keypad can be entered directly. 
 

Using a mouse 

Moving within the worksheet with the  help of a mouse also occurs as it 

might have been expected. To change the active cell, one should click the 

desired cell, and it will be active. If the cell that you want to activate is, not 

visible in the workbook, one can use the scrollbar to scroll the window in any 

direction. 

When the scrollbars or scrolling through IntelliMouse are used an active 

cell does not change, only the worksheet scrolls. To change the active cell  it 

is necessary to click on a new cell after scrolling. 

Using menus and toolbars 

If you have worked in any program before, then you should not have 

any problems when working in Excel. The user interface is Excel (that is, the 
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menu and the toolbar) will look familiar, so far as the location and purpose of 

instructions in all the programs are the same. 

 

Using the menu 

In Excel, as in all other Windows applications, there is a menu bar, 

located below the title bar (Fig. 1.3). Excel menu changes depending on the 

nature of your actions. For example, if you are working with a chart, the Excel 

menu adjusts so that to give you tools to work with charts. 

 

 

 
Fig. 1.3. Excel menus and submenus 

 

There is nothing easier than to get access to the menu with the help of 

a mouse. Click on the required menu, it will open and you will see a list of its 

elements (see Fig. 1.3). Some menu items have additional submenus. If you 

click on such menu item, the submenu will appear on the right side of it. 

Menu items that have a submenu are marked with a small triangle on the 

right side. For example, the View Toolbars submenu is shown in Fig. 1.3. 

Sometimes a menu item is highlighted with gray colour. This is the way to 

indicate that this item is not designed for the operation you are performing at 

the moment. 

Selecting a menu item, the name of which includes the ellipsis (three 

dots), always results in the dialog box opening. Menu commands that have 

no ellipses are executed immediately. For example, when you select Insert > 

Cells ... а dialog box appears, because the program needs more information 

about the executed command. The Insert > String command does not need 

any additional information, so it is executed as soon as it has been chosen. 

Almost any command in Excel can be disabled with the Corrections > Undo 

command. Thus, you can undo the last 16 executed commands. Instead of 

choosing the Corrections > Undo command, you can use the Undo button, 
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which is located on the standard toolbar. In addition, to undo the last action 

you can use the key combination <Ctrl+Z>. 
 

Using the context menus 

In addition to the main menu Excel provides many other context menus. 

These menus are context-sensitive, that is, their content depends on the 

nature of the operation that you are performing at the moment. There are only 

the commands that are most commonly used to work with the selected 

element at this point. The context menu can be called for almost any object in 

Excel. To do this, click on the right mouse button. In Fig. 1.4 the context me-

nu that appears when you right-click on the cell is shown. 

 

The use of key combinations 

For some menu items the shortcuts are provided. Usually a key 

combination is shown next to the name of the menu item. For example, the 

keyboard equivalent of the Corrections > Find command is the combination 

<Ctrl+F>. The combinations of frequently used commands you can see in the 

menu to the right of their names. 

 

 
 

Fig. 1.4. The context menu 

 

Excel toolbars 

Excel, as almost all modern applications, includes a handy graphic 

toolbar. Most of the toolbar buttons replace some of the menu commands. 

For example, the Copy button replaces the Corrections > Copy command. 

However, some buttons do not have equivalents in the menu, such as 

AutoSum button, which automatically inserts the formula for calculating the 

sum of the values in a specified range of cells. 
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To find out what this or that toolbar button is meant for move the mouse 

pointer to it (but do not click on it). Next to the cursor appears a small yellow 

window with tip that contains the name of a button. If a tip is not seen on  

the screen, select the Tools > Setting up command. In the window that 

appears, navigate to the tab Options and select the Display button tool 

tips.  

Table. 1.2 lists the most commonly used built-in Excel toolbars. 

 

Hiding and displaying toolbars 

By default, Excel displays two toolbars – standard and formatting ones. 

In addition, you can create your own toolbars, which will consist of the buttons 

that you find most useful. 

 

Table 1.2 

 

Excel toolbars 

 

Name  Characteristics 

Standard Running the most frequently used commands 

Formatting Changing the appearance of a worksheet or chart 

WordArt Inserting or editing an artistic text 

Web site Access to the Internet with Excel 

Border Adding border (frame) around the selected cells 

Charts Working with charts 

Dependences Identifying errors in the worksheet and displaying the relationships 

between formulas 

Protection Management of protected worksheets and books 

Peer review Operations with the notes to the cells 

Drawing Inserting and editing pictures on a worksheet 

Pivot tables Working with pivot tables 

Forms Adding to the worksheet controls (buttons, lists, etc.) 

 

To hide a toolbar, or display it on the screen, choose View > Toolbars 

or right-click any toolbar or the menu bar. The result is a list of toolbars. The 

toolbar, activated in the list is visible. To hide the toolbar, one should click on 

its name in the list. And vice versa to show a hidden toolbar, you can also 

click on its name. 

../../../Nor6bti
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To access all the toolbar, choose Service > Settings. The Toolbar tab 

of the dialog box appears on the screen Settings for a list of available 

toolbars. Check the boxes next to each panel to display them. 

Constructing of the first worksheet 

At the first stage you need to run Excel and deploy a work window so 

that it fills the whole screen. Then, expand clean workbook, which will be 

called Book1. If any book is open in order to open a new one, click on the 

New button of the standard toolbar. First you need to enter the headers of the 

row and column in a worksheet Sheet1. 

Perform the following steps. 

1. Move A3 with the arrow keys.  

2. In the Name field enter the address of the cell. 

3. In the cell A3, enter the North. To do this, type the text and press 

<Enter> key. Depending on your settings, Excel either move the cursor to the 

cell A4, or leave it in the cell A3. 

4. Move the table cursor into the cell A4, enter the South and press 

<Enter> key. 

5. In the cell A5, type Total and press <Enter> key. 

6. Move the table cursor into the cell B2, enter the 1st quarter and 

press <Enter> key.  

Three other titles could be entered manually, but let's make Excel work. 

7. Notice the small box in the lower right corner of the table cursor. It is 

called the fill handle. If you place the mouse pointer on the marker, it will ta-

ke the shape of a black cross. 

8. Place the mouse pointer over the fill handle so that the pointer turns 

into a cross. Then click and drag the pointer to the right until you have iden-

tified three cells on the right side (C2, D2 and E2). Release the mouse button 

and you will see that the program automatically enters instead of you three 

headers. This is an example of using the AutoComplete. 

As a result, you should get a table, such as in Fig. 1.5. 
 

 
 

Fig. 1.5. Worksheet after entering the headers 
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Data entering 

At this stage, you need to enter sales volumes per quarter for each 

region. 

1. Move the tables cursor into the cell B3, type number 123 and press 

<Enter> key. 

2. Move the table cursor into to the other tables cells and enter the 

following data.  

The worksheet will look as in Fig. 1.6. 
 

 
 

Fig. 1.6. Worksheet with entered data on sales volumes 

 

Creating a formula  

Let's now create the formula for calculating the total sum by the regions. 

To do this, follow the instructions below. 

1. Move the table cursor into the cell В5. 

2. Find in the Standard toolbar, located below the menu bar, 

AutoSum button and click it. This button depicts the Greek letter "sigma". 

The program has placed into the cell В5 the following: = SUM(ВЗ:В4). This 

is the a formula that calculates the sum of the values of the cells that are in 

the range ВЗ:В4. 

3. Press <Enter> key to enter the formula. You will see that in the cell 

B5 the sum of two numbers appears. You could repeat the same operation 

for the three quarters remaining, but it is much easier to copy the formula into 

three cells, located on the right side. 

4. Move the table cursor into the cell В5. 

5. Place the mouse pointer over the fill handle. When it turns into a 

cross, click and drag the pointer three cells to the right. When you release the 

mouse button, you will see that Excel copied the formula into selected cell. 

When data changes, these formulas are recalculated automatically and the 

new results are displayed. 
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Formatting a table 

The table you have created can look better. At this stage one can take 

an opportunity of the Excel automatical formatting. Perform the following 

steps. 

1. Place the table cursor into any cell. 

2. Select the command Format > AutoFormat. The result will be the 

following: Excel will determine the boundaries of the table and highlight all of 

it, and will open the Auto Format dialog box. 

3. The Auto Format dialog box offers 16 ready formats to choose. Click 

on the format you like. 

4. Click on the button ОК. 

Your table should look like in Fig. 1.7. 

Adding a title heading 

At this stage, we introduce the table header, select it in bold and place 

in the center relative to the table columns. For this purpose do the following. 

1. Place the table cursor into the cell А1. 

2. Enter The volume of sales by regions and press <Enter> key. 

3. Move the cursor back to the table cell A1, if it was in a different cell, 

and click the Bold key, located on the formatting toolbar. This button depicts 

the capital large letter B. 

4. Click on the button drop-down Size, which is located on the 

formatting toolbar. Choose from the list number 14. 

5. Click on the cell А1 and drag mouse pointer to the right to select the 

cells А1, В1, C1, D1 and Е1 (i.e. range А1:Е1). Just don't drag the fill handle. 

You need to select the cell, and not to copy the cell А1. 

6. Click on the button Merge and Center, located on the formatting 

toolbar. As a result, the text that is in the cell A1, will be centered relative to 

the selected cells. 

Now your worksheet should look as in Fig. 1.7. 

 

 
 

Fig. 1.7. Formatted table with the header 
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Saving a workbook 

All you have done so far has been stored in your computer RAM. And if 

suddenly lost power, all will be lost. So it's time to save the results of the work 

done in the file. Name it, for example, My first workbook. 

1. It depicts a diskette. Excel will open the dialog box Saving docu-

ment.  

2. Click on the Save button on the standard toolbar. 

3. In the File Name enter My first workbook, and click on the Save 

button or press <Enter>. 

The program will save the workbook in a file. Thus workbook is left 

open, and you can continue using it. 

 

Laboratory work No. 2 

Submission of statistical data: graphs 

 

The purpose of the work is to acquire the skills of analysis of statistical 

data using the graphical method in the package MS Excel. 

Its tasks are to construct the graphs on the basis of statistical data, 

see the types of the graphs in MS Excel, get acquainted with the "Chart 

Wizard" possibilities. 

 

Guidelines 

 

Building a chart by pressing a keyboard single key. 

The following sequence of actions gives the opportunity to create a 

chart on a separate sheet. 

1. Entering the input data, which will be used to create a chart (Fig. 2.1). 

 

 

 

Fig. 2.1. Input data 
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2. Select the range of data, including row and column headers. For 

example, if the chart is based on the data presented in Fig. 2.1, you need to 

highlight the range А1:С4. 

3. Press the key F11. Excel will build basing on a selected range a chart 

and put it on a new chart sheet with the name of chart 1. In Fig. 2.2 the result 

of this procedure is shown. 
 

 
 

Fig. 2.2. The chart built by one click of keyboard button  
 

Building a chart by pressing a single button mouse 

The approach implies the implementation of such actions: 

1. Make sure that the Charts toolbar is on the screen. 

2. Select the data basing on which chart 1 will be created. 

3. Press the Chart type button, which is located on the Charts toolbar, 

and select the type of a chart (Fig. 2.3). 
 

 
 

Fig. 2.3. Building a chart by clicking a single mouse button 
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Using the Chart Wizard function. In practice, it often happens that it is 

necessary to specify certain chart settings. In this case, you need to make 

changes to the settings manually after creating a chart. But for more control it 

is better to use the Chart Wizard, which provides for the implementation of 

such a sequence of actions. 

Selecting Data. After entering the input data, highlight indicators for the 

construction of the chart to simplify the work (Fig. 2.4). Otherwise, you can 

choose them in the second Wizard dialog box. 

In this example (Fig. 2.4) the range А3:Е9 was selected. This range 

contains the column headers, but it doesn't include the name of a chart, 

which is stored in the cell А1.  
 

 
 

Fig. 2.4. Initial data 
 

Starting the Chart Wizard. To do this, click on the Chart Wizard 

pictogram, which is located on the toolbar, or choose Insert – Chart. You will 

see the first of the four Chart Wizard dialog boxes on the screen. 

You can always go back to the previous stage of the work, pressing the 

Back button, and the next one – the Next button. To immediately complete 

the construction of a chart, click Finish. 

Chart Wizard: Step 1 of 4. Fig. 2.5 presents the first Wizard window, 

where the type of a chart is determined. The dialog box contains two tabs – 

Standard and Custom. The Standard tab includes 14 basic chart types with 

relevant subtypes, and the Custom tab contains some special types of charts, 

including the manufacturer's. 

For this example, it is expedient to choose a chart type Chart with 

markers. From the list Type select the element Graph, then click the icon 

graph of a suitable type (subtype) in the list View. 

After determining the Type and View (subtype) charts, click on the Next 

button to proceed to the next step. 
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Chart Wizard: step 2 of 4. At the second step of the Chart Wizard 

function (Fig. 2.6) you can define such parameters: 

check out the range of input data, if you want to change it; 

determine the orientation of the data (rows or columns); 

verify whether Excel divided the categories source data and ranks 

correctly. 

Checking a range of input data. At the second step dialog box Chart 

Wizard contains two tabs: Data Range and the Range of Row data ones. 
 

 
 

Fig. 2.5. The first window Chart Wizard: Chart Type 
 

 
 

Fig. 2.6. The second window of the Chart Wizard: data range tab 
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Range field contains a reference to a range that has been allocated 

before starting the Chart Wizard tool. If you have selected only one cell, Excel 

will show a link to the foreseen range of input data. 

If the data range isn't defined properly, it can be changed. To do this, 

press the Range field and highlight the data necessary on the worksheet. 

Change the orientation of the data. Data orientation cardinally affects 

the appearance of a chart. Excel itself performs this procedure. In case of auto-

matic execution of Excel, this option is not implemented correctly, the orien-

tation can be set manually by selecting the desired position for Series switch.  

Delimiting the data categories and series. When Excel mistakenly identi-

fied the Year in both columns A series of data, and in fact, the number of the 

year is the name of the category and should be treated as text and does not 

appear in the chart as a numeric value, they must be set manually. To do this, 

go to the Series tab (Fig. 2.7). 

The Series list contains the names of all the series data of the chart. In Fig. 2.7 

the name of Year series is in the cell A3, and value – in the range of А4:А9. 

As a Year series is not really a series, and contains the name of the X-axis, 

then it must be removed from this list. To do this, highlight the necessary 

series and press the Delete button. As a result of the appearance of chart will 

change and will not have a signature on the category axis. 
 

 
 

Fig. 2.7. The second window of the Chart Wizard: Series tab 
 

Signatures of the X axis field is empty, so you must specify a range that 

contains these signatures. To add a signature, click on the field and select the 

А4:А9 range. After that the years are displayed as categories on the hori-

zontal axis, and the chart itself consists of four rows of data (Fig. 2.8). 
 

 
 

Fig. 2.8. Tab after removal of one row and adding the X-axis Labels 
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Chart Wizard: step 3 of 4. In the third dialog box the Chart Wizard set 

most of the options that define the appearance of a chart (Fig. 2.9). The options 

depend on the type of a chart. The dialog box contains six tabs. 

Headlines. Adding Chart Titles. 

Axis. Displaying and deleting the axis, as well delimiting their types. 

Grid lines. Defining the grid settings if it is in the chart. 

Legend. Determining the presence and location of a legend. 

Data labels. Determining the presence and place name data. 

Table of data. Determining the presence of the data table.   

Fig. 2.9 displays the change of  only two parameters in the Titles tab. In 

the Chart  the Level of education of regular readers of the periodicals, and in 

the X-axis (of categories) – the Year were entered.  

 

 
 

Fig. 2.9. The third window of the Chart Wizard: 

options that determine the appearance of the chart 
 

Chart Wizard: step 4 of 4. In the last dialog box it should be indicated 

where to place the chart. The switch is set to Private if you want to place the 

chart on a separate sheet, or if the position is Available, to create an 

introduced chart (Fig. 2.10). Click Finish. 
 

 
 

Fig. 2.10. The fourth window of the Chart Wizard: the location  

of the chart is specified 
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If you created a nested chart, Excel will place it in the centre of the 

active window (Fig. 2.11). 
 

 
 

Fig. 2.11. The chart constructed by means of Chart Wizard tool based  

on the specified parameters 
 

Changing the settings of the chart (elements). The chart constructed can 

be modified any time. But before starting to modify the chart (any item), it is 

necessary to activate it by clicking on a chart (or element).  

The most frequently used settings of charts are: 

moving and resizing a chart (nested) in order to move the chart one 

must click on its border, and then drag. To change the size of the chart you 

need to drag one of eight size markers on the border of the chart; 

changing the type of a chart. The first method involves pressing the 

Chart Type button, which is located on the tool bar Charts (see Fig. 2.3) and 

the choice of one of the 18 main types of charts. The second way is to right-

click on the chart and choose from the shortcut menu Chart Type; 

moving and deleting chart elements. Some elements of the chart can 

be moved (for example, titles, legend, or data table). To move a chart ele-

ment, select it by clicking with the mouse, then drag it to the right place of  

the chart. To delete a chart element you need to select it, and then press 

Delete; 

formatting the chart and its elements. Activation of a chart (chart 

element) allows to change parameters. The first method involves the use of 

commands from the context menu. The second one assumes the use of 

Charts toolbar commands (see Fig. 2.3), and the third one is the use of a set 

Level of education of regular readers of periodical editions 

Level of education of regular readers of 

periodical editions 
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of commands that are on the other toolbars (such as Fill colour data series, 

Bold chart legends, etc.). 
 

Laboratory work No. 3 

Summarization and grouping of statistical data 
 

The purpose of the work is to acquire the skills of grouping data into 

MS Excel. 

Its task is to group statistical data using the "Data Analysis" add-in of 

MS Excel. 
 

Guidelines 
 

Summarization and grouping of statistical data should be performed by 

the mode "Histogram", "Data Analysis" add-in. 

The mode "Histogram" is used to calculate the frequency of contact da-

ta in the specified boundaries of intervals, and to build the histogram of inter-

val variation distribution range. 

The dialog box of this regime (Fig. 3.1) assumes the following parame-

ters: 

1.  Input range, i.e. the location of the input data on your worksheet.  

2.  Bin range (optional parameter), i.e. entering a link to the cells containing a 

set of limits that define the intervals (pocket). These values must be entered 

in ascending order. In Microsoft Excel the number pointing the intervals by the 

data is calculated. The limits of intervals have strict lower limit and not strict 

upper limit. 
 

 
 

Fig. 3.1. "Histogram" window 
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If the bin range was not entered, then a set of intervals, evenly 

distributed between the minimum and maximum values of the data will be 

generated automatically. 

3.  Labels, which are set in an active state, if the first row (column) in the 

input range contains titles. If no titles, checkbox should be deactivated. In this 

case, standard names for the output range will be automatically created. 

4.  Output range / New Worksheet / New Workbook activates the field 

where the link to the upper-left cell of the output range should be entered. 

The output range is automatically detected and a message appears in case of 

the possible imposition of the original range to the output range. 

5.  Pareto (sorted histogram) is set in an active state to represent the 

data in descending order of frequency. If it is unchecked, the data in the 

output range will be listed in order of intervals. 

6.  Cumulative percentage is set in an active state to calculate the 

percentage of accumulated frequencies and inclusion of the graph of accu-

mulated frequencies in the histogram. 

7.  Chart Output is set in the active state for automatic building of an 

embedded chart on a worksheet containing the input range. 

Example. The GDP volume per capita (current USD) in 2011 is shown 

in Table 3.1. 

Enter input data into the cells A1:B50. 

You need to construct a histogram and accumulated frequencies in the 

histogram. In order to solve the task the "Histogram" mode could be used. 

The parameters in the dialog ''Histogram'' are shown in Fig. 3.2. 
 

Table 3.1 
 

Input data 
 

Country name 2011 Country name 2011 

1 2 3 4 

Albania 4,029.73 Latvia 12,726.4 

Armenia 3,305.49 Lithuania 13,339.2 

Austria 49,707.1 Luxembourg 115,038 

Azerbaijan 6,915.76 Macedonia, FYR 4,925.34 

Belarus 5,820.35 Moldova 1,966.93 

Belgium 46,469.2 Montenegro 7,197.13 

Bosnia and Herzegovina 4,820.67 Netherlands 50,087.3 

Bulgaria 7,158.12 Norway 98,102.5 

Croatia 14,488.3 Poland 13,462.9 



22 

Table 3.1 (the end) 

 

1 2 3 4 

Cyprus 30,670.3 Portugal 22,329.8 

Czech Republic 20,407.3 Romania 8,405.49 

Denmark 59,683.8 Russian Federation 13,089.3 

Estonia 16,555,8 Serbia 6,203.47 

Finland 49,391.3 Slovak Republic 17,646 

France 42,377.4 Slovenia 24,141.9 

Georgia 3,202.53 Spain 32,244.2 

Germany 43,689.3 Sweden 56,927 

Greece 26,427.2 Switzerland 80,390.8 

Hungary 14,043.7 Tajikistan 934.82 

Iceland 44,072.3 Turkey 10,498.3 

Ireland 48,423.2 Turkmenistan 4,721.96 

Italy 36,115.7 Ukraine 3,615.38 

Kazakhstan 11,244.9 United Kingdom 38,817.8 

Kosovo 3,592.6 Uzbekistan 1,545.93 

Kirgiz Republic 1,074.74    

 

 
 

Fig 3.2. Filling the ''Histogram'' window 

 

The frequencies and cumulative frequencies are presented in Table 3.2.  
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Table 3.2 

 

The frequencies and cumulative frequencies 

 

Bin Frequency Cumulative % 

934.8201 1 2.04 % 

17,235.26 26 55.10 % 

33,535.69 7 69.39 % 

49,836.13 9 87.76 % 

66,136.57 3 93.88 % 

82,437 1 95.92 % 

98,737.44 1 97.96 % 

More 1 100.00 % 

 

So we see that uneven distribution of countries by the indicator ''the 

GDP per capita'': 26 countries of 49 have a value of the GDP per capita from 

934.82 dollars to 17,235.26 dollars. 

The histogram of constructed and accumulated frequencies is shown in 

Fig. 3.3. 
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Table 3.2 "Cumulative %" explains the calculation of the accumulated 

frequencies. Cumulative frequency is calculated based on the frequency (see 

Table 3.2 "Frequency" column). Each value of cumulative frequency is divi-

ded by the maximum accumulated value. The result is relative frequency 

expressed in fractions of a unit. After the transformation to a percentage 

format the final result is obtained. 

 

Laboratory work No. 4  

Generalizing statistical indicators 

 

The purpose of the work is to acquire the skills of calculating the 

averages in MS Excel. 

Its task is to calculate relative and average statistical indicators by 

means of MS Excel. 

 

Guidelines 

 

Absolute values characterize the size of socioeconomic phe-

nomena. This refers to the aggregate amount or its certain parts (a 

number of elements) and the corresponding values of volume attri-

butes.  

Absolute statistical indicators are of indisputable statistical significance 

in management, but in-depth socioeconomic analysis of the facts requires 

various comparisons. The values of statistics are compared in time (in rela-

tion to one object) and in space (between the objects), different signs of the 

same object are correlated.  

The result of the comparison is the relative statistical indicator that cha-

racterizes the measure of quantitative correlation of dissimilar or similar indi-

cators.  

Each relative indicator is a fraction, the numerator of which is the 

comparable value, and the denominator is the base of comparison. A 

relative indicator shows how many times the comparable value exceeds 

the baseline or the proportion of the base of comparison. Formulas for 

calculating the statistical indicators are given in Table 4.1. 
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Table 4.1 

 

Formulas of calculation of statistical indicators 

 

Name of indicator Formulas of calculation 

Relative indicator of dynamics 

0У
1У

=RID
 

Relative indicator of plan 

performance  plУ
1У

=RIPP  

Relative indicator of a planned 

target 0У

plУ
RIPT   

Arithmetic average value 

Simple: 
n

n

1
х

=
set a of Volume

value attribute an of Volume
=x



. 

Weighed: 





m

1
jf

m

1
jfjx

=x . 

Harmonic average value 
Simple: 


n

1 x

1

n
=x . 

Weighed: 





m

1
jM

x

1

m

1
jM

=x . 

Geometric average value 
Simple: n

n

1
ix=n

nx...3x2x1x=x  . 

Weighed: n
m

1

jn

j
x=x   

 

Let's consider the example of calculation of relative indicators by means 

of MS Excel.  
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Task 1 

 

We have data on the sales of industry products, thousands (Table 4.2). 

 

Table 4.2 

 

Input data 

 
 

Enterprise number 
Sales in the 1st 

quarter 

Plan for the 2nd 

quarter 

Sales in the 2nd 

quarter 

1 8,500 8,650 8,720 

2 7,540 7,650 7,700 

3 9,900 10,400 10,670 

4 5,900 6,000 5,950 

 

Calculate the percentage of statistic indicators that characterize the 

planned target, performance of the plan and the dynamics of sales for each 

enterprise and for the union as a whole. Make a conclusion. 

Relative indicator of a planned target is calculated as the ratio of the 

planned sign in the current period to the actual characteristics of the previous 

period. Calculation formulas in the program Excel (Fig. 4.1) begins with the sign 

"=" in the row. To begin with one highlight the value should be in the numerator 

(C2), put a division mark and select the values which should be in the deno-

minator (B2), then multiply the fraction by 100 (C2/B2 × 100), press Enter in order 

to obtain numerical results. The indicators of other enterprises are calculated in 

the similar way or you can select the result and expand it up to the column. 

 

 

 

Fig. 4.1. The calculation of the relative indicator of a planned target 
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The calculation of a relative indicator of performance of a plan and the 

relative indicator of the dynamics are similar to the calculation of the relative 

indicator of a planned target (Fig. 4.2 and 4.3). The numerator and deno-

minator of these variables are relevant indicators which are used for their cal-

culation (see formula).  

 

 
 

Fig. 4.2. The calculation of the relative indicator of a plan performance  
 

In order to determine these indicators for the association as a whole we 

need to calculate the sum of input data (in columns) by using AutoSum (Σ) on 

the toolbar Excel (Fig. 4.4). The calculation of relative indicators of the 

planned target, performance of the plan and the dynamics for the association 

are calculated similar to the calculation of indicators for each company by the 

ratio of two values (Fig. 4.5).  
 

 
 

Fig. 4.3. The calculation of the relative indicator of the dynamics 
 

 
 

Fig. 4.4. AutoSum 
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Fig. 4.5. The calculation of indicators for the association 
 

The relative indicator of a planned target characterizes the plan change 

in the current period compared to the actual value of the previous period. It 

can be concluded by the first company – in the current period the company 

planned to realize production that is by 1.76 % more than actually realized in 

the first quarter. For the association it is planned to realize production that is 

by 2.7 % more than in the previous period.  

Relative indicator of the plan performance shows the percentage of actual 

value changes compared to the plan. In the second quarter the second company 

sold products by 0.65 % more than it was planned. Industrial enterprises sold 

products by 1.04 % more than it was planned. 

Relative indicator of the dynamics determines the dynamics of the changes 

of socioeconomic phenomenon in time. It can be concluded that in the second 

quarter all the enterprises sold products by 3.77 % more than in the first one. 
 

Task 2 

 

Consider the combination of using the relative indicators of the 

dynamics, structure and coordination (Table 4.3). 
 

Table 4.3 
 

Material reserves of the company 
 

Material reserves 

Reserves, thou-

sand UAH, at the 

end of the quarter 

The ІV 

quarter, 

% the ІІІ 

quarter 

Structure of reserves, 

% to the end of the 

quarter 

Structural 

shifts, p.p. 

ІІІ ІV ІІІ ІV 

Raw materials 119 122.5 102.5 68 62 –6 

Finished product 56 74 132.1 32 38 +6 

Total 175 196 112.0 100 100 0 
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Relative indicators of the structure are calculated as the ratio of the 

share to the whole, that is the row line "Raw materials" (B3) is divided by the 

row line "Total" (B5) and multiplied by 100 % (Fig. 4.6). Sign ''$'' in denomi-

nator fixes the cell if then you shift formula. 

Structural changes are calculated as the difference between the struc-

ture of reserves in the fourth and the third quarters. 
 

 
 

Fig. 4.6. The calculation of the relative indicator of the structure 
 

In the fourth quarter reserves generally increased 1.12 times, i.e. by 

12 % (Fig. 4.7). As reserves consist of two functionally distinct components, it 

is necessary to assess the dynamics of each of them. So, raw materials 

increased only by 2.5 %, while reserves of finished product – by 32.1 %. 

Irregularity of dynamics of individual components has led to changes in the 

structure of reserves. In the third quarter the share of raw materials was 68 %, 

in the fourth quarter it decreased to 62 %, that is by 6 percentage points. Due 

to structural changes the proportions between the constituent parts have 

changed: in the third quarter for 1 UAH of reserves of finished products 2.125 

USD of raw materials reserves (119 : 56 = 2.125) were accounted, in the 

fourth quarter it decreased to 1.65 (122 : 74 = 1.65).  
 

 
 

Fig. 4.7. The calculation of structural changes 

 

As most of the socioeconomic phenomena are characterized by additi-

vity of volumes (sugar, fuel, etc.), so the arithmetic average is the most com-
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mon one. It is calculated by dividing the total value signs by the volume set. 

Simple arithmetic average is calculated for primary ungrouped data. 
 

Task 3 
 

For example, insurance company paid insurance benefits for five damaged 

objects, thousand UAH: 18, 27, 22, 30, 23. Enter the data into the cells B2 and F2. 

In order to calculate the average payment of insurance one should put 

in Excel sign B2 "=" into the cell and select ''function'' (f) on the formula bar. 

The possibilities of this module are presented in the window (Fig. 4.8). 

In order to calculate the average value one should select the AVERAGE 

function, (B3:F3) and in the dialog "Function Arguments" (Fig. 4.9), click "OK"  

(Fig. 4.10). 
 

 
 

Fig. 4.8. Dialog window "Wizard Functions" 

 

 
 

Fig. 4.9. Dialog window "Function Arguments" 
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Fig. 4.10. The result of the calculation of the average  

insurance payment  

 

On the average, the insurance company paid insurance benefits for five 

damaged objects to the amount of 24 thousand UAH. 

 

Task 4 

 

We have data concerning two companies that produce the same 

productions, (Table 4.4). 

 

Table 4.4 
 

Input data 

 

Company 

2011 2012 

Time 

expenditure per 

unit, hours 

Produced units 

Time 

expenditure per 

unit, hours 

Time 

expenditure on 

all products, 

hours 

А 2.0 150 1.9 380 

B 3.0 250 3.05 840 

 

Determine the average time expenditure per unit by two companies in 

2011 – 2012. 

To determine the average time expenditure in 2011 use a formula of 

arithmetic weighted average, because we have an attribute value (time 

expenditure per unit is ''x'') and the frequency of its appearance (produced 

units are ''f''). Enter the formula =B3×C3 into the cell F3 and expand this 

formula to the whole column. In the cell F5 calculate the sum of a column: 

press sign AutoSum ''Σ'' on the toolbar or press "=" and choose the SUM 

formula in the formula bar. Calculate the sum in the cell C5 (Fig. 4.11).  
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Fig. 4.11. The calculation of the arithmetic weighted average 

 

To calculate the average value enter the formula =F5/C5 into the cell 

G5 and press ''Enter'' and get the result: in 2011 the average time costs of 

production of companies A and B was 2.625 hours.  

In order to determine the average time expenditure in 2012 we need to 

use the formula of a weighted harmonic average value as we have signs 

(time spent per unit of product is "x") and general expenses ''M''. Enter the 

formula =E3/D3 into the cell H3 and expand this formula to the whole column. 

Calculate the sum of a column in the cell H5: press the AutoSum Σ sign on 

the toolbar or press "=" and choose the SUM formula in the formula bar. 

Calculate sum in the cell E5. 

 

 

 

Fig. 4.12. The calculation of harmonic weighted average  

 

To calculate the average value enter the formula =E5/H5 into the cell I5, 

press "Enter" and get the result: in 2012 the average time expenditure for 

production of companies A and B were 2.57 hours. 
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Laboratory work No. 5 

Analysis of distribution series 

 

The purpose of the work is to gain the ability to analyze the 

distribution series by means of MS Excel. 

Its task is to analyze the statistical distribution series with the help of 

"Analysis Toolpack". 

 

Guidelines 

 

Base formulas for calculating the characteristics of distribution series 

are presented in Table 5.1. 

 

Table 5.1 

 

Formulas for calculating the characteristics of distribution series 

 

Mode 
0 0-1

0 0-1 0 0+1

MM

o 0

MM MM

(f-f)
M=x+i

(f-f)+(f-f) 

Median 
 e

e

i M-1

e 0

M

1
f-S

2M=x+i ,
f

 

Variance 




if
if

2)ixi(x
=2σ  

Standard deviation 2σ=σ  

Coefficient of variation %100
x

K 


  

 

You can solve the tasks of distribution series analysis in Excel by means 

of "Analysis Toolpack" and built-in statistical functions. Let's consider the 

order of work in Excel. 

Analysis of ungrouped statistical data. The work starts with running 

Excel (similar to running the other applications – using the Start menu or by 

means of the shortcut). The indicators are not necessarily entered into the 

input spreadsheet when forming the file, you can move it from Microsoft Offi-
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ce documents through the clipboard. Then you can transform and visualize 

the data (Fig. 5.1). 
 

 
 

Fig. 5.1. Input data 
 

Descriptive Statistics mode is used to generate one-dimensional sta-

tistical report on basic indicators of position, scattering and asymmetry of the 

population which is analyzed. To move to this mode you need to enter the 

menu item Data – Data Analysis and select this mode (Fig. 5.2). 
 

 
 

Fig. 5.2. Selecting the Descriptive Statistics mode 
 

In the dialog box of this mode (Fig. 5.3) the following parameters are given: 

1. Input range, i.e. entering the cells that contain statistical data. 

2. Grouping, i.e. setting the position by columns or by rows, depending 

on the location of the data in the input range. 

3. Labels in the first row which are activated if the first row (column) in 

the input range contains column labels. If you have no column labels this 

parameter should be deactivated. In this case standard names for the output 

range data will be automatically created. 
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4. Output range / New Worksheet / New Workbook. 

In the Output range position you need to enter a link to the upper-left cell of 

output range in the box. The output range is automatically detected, and a message 

appears in the case of the possible imposition of the original range of the input data. 

In the New Worksheet position new worksheet opens. Excel will enter 

the results starting with the cell A1. If you want to specify the name of the new 

worksheet enter the name in the box located in front of it. 

In the New Workbook position a new workbook opens. Excel will enter 

the results at the cell A1 on the first worksheet. 

5. Summary Statistics  which is activated if the output range  gets one 

field for each Descriptive Statistics indicator. 

6. Confidence level for mean is activated if the output table inclu-

des a row for maximum sampling error at the prescribed level of reliability. 

7. K-th largest which is activated if the row for the k-th largest (from a 

maximum xmax) value of the sample should be included in output table. If 

k = 1, then the row will contain the maximum value of the sample. 

8. K-th smallest which is activated if the output table includes the row 

for the k-th smallest (from xmin) value of the sample. Enter a number k in the 

box. If k = 1, then the row will contain the minimum value of the sample.  

Input parameters of Descriptive Statistics mode are presented in Fig. 5.3, 

and the calculated parameters of this mode – in Fig. 5.4. 

 

 
 

Fig. 5.3. The parameters of Descriptive Statistics mode 
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Fig. 5.4. The calculated parameters of Descriptive Statistics mode 

 

According to the data the coefficient of oscillation is calculated as follows: 
 

%;74.29%100
81.517

00.154
%100

x

R
RK 

 

 

the coefficient of variation is: 
 

%.40.8%100
81.517

53.43
%100

x
K 


  

 

Analysis of grouped statistical data. After entering or moving input 

data from Microsoft Office documents via clipboard into a spreadsheet Excel, 

if necessary, you can transform and visualize the row data. In this case, you 

need to add a column with individual values of signs (midpoint of interval) for 

each group (Fig. 5.5). 

The function for calculating the weighted arithmetic average is not 

present in Excel. But it is possible to obtain it by combination of other functions. 

The cell C9 contains the formula =SUMPRODUCT(C3:C8;B3:B8)/ 

SUM(B3:B8), by means of which the average current assets is calculated 

(Fig. 5.5). 



37 

 

 

Fig. 5.5. The calculation of the average current assets 

 

For the determination of mode (3) and median (4) one should make so-

me calculations (Fig. 5.6 – 5.7). 

The calculation of mode is presented in Fig. 5.6. The content of the cells 

(Fig. 5.6) is as follows: 

the cell C9 contains the formula =MAX(B3:B8) with the help of which 

the modal number of companies is calculated; 

the cell C10 contains the formula =MATCH(C9;B3:B8;0) by means of 

which the displacement of modal value is calculated in an array of B3:B8; 

the cell C11 contains the formula =INDEX(A3:A8;C10;1), i.e. the modal 

interval of the amount of current assets in the A3:A8 array; 

the cell C12 contains the formula =LEFT(C11;1) which shows the lower 

limit of the modal interval of the amount of current assets; 

the cell C13 contains the formula =INDEX(B3:B8;C10-1;1), i.e. the 

number of enterprises with modal interval of current assets (fM0-1) in the B3:B8 

array; 

the cell C14 contains the formula =INDEX(B3: B8;C10+1;1), i.e. the 

number of enterprises with larger amount of current assets (fM0+1) in the B3:B8 

array; 

the cell C15 contains the formula =C12+2×((C9-C13)/((C9-C13)+(C9-C14))) 

for calculating the mode of the amount of current assets. 
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Fig. 5.6. The calculation of the mode 

 

Due to the fact that the median divides the population in half, it will be 

where the cumulative frequency is a half or more than half of the total amount 

of frequencies, and the previous cumulative frequency is less than a half of 

the population size (Fig. 5.7). 

The content of cells (Fig. 5.7) is as follows: 

in the cells C3:C8 cumulative frequency is calculated (for example, the 

cell C5 contains the formula =C4+B5); 

the cell B9 contains the formula =SUM(B3:B8) by means of which the 

number of population (the number of enterprises) is calculated; 

the cell C10 contains the formula =B9/2 which determines a half of the 

number of population (50 % of enterprises); 

the cell C11 contains the formula =MATCH(C10;C3:C8;1), i.e. the num-

ber of position of the largest value among the numbers less than it or equal to 

the middle of the interval is determined in the C3:C8 array; 

the cell C12 contains the formula =INDEX(C3:C8;C11;1), i.e. a number 

that meets the search criteria, formed in the cell C11 and taken from the 

C3:C8 array; 

the cell C13 contains the formula =IF(C10=C12;C11;C11+1) by means 

of which the shift on the median interval is calculated; 

the cell C14 contains the formula =INDEX(B3:B8;C13;1) reflecting the 

frequency of the median interval; 
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the cell C15 contains the formula =INDEX(A3:A8;C13;1), i.e. the me-

dian interval found in the A3:A8 array; 

the cell C16 contains the formula =LEFT(C15;1) reflecting the lower li-

mit of median interval; 

the cell C17 contains the formula =INDEX(C3: C8;C13-1;1) calculating 

the value of the cumulative frequency before the median interval; 

the cell C18 contains the formula =C16+2×((B9/2-C17)/C14) calculating 

the median of the current assets amount. 

 

 

 

Fig. 5.7. The calculation of the median 

 

The calculation of mean square deviation allows to determine the 

coefficient of variation (Fig. 5.8). 

These parameters (Fig. 5.8) were determined with the help of the 

following formulas: 

the cell C10 contains =(SUMPRODUCT(POWER(C3:C8-C9; 2);B3:B8)) 

/SUM(B3:B8) for calculating the variance; 

the cell C11 contains =SQRT(C10) for calculating the mean square 

deviation; 

the cell C12 contains =(C11/C9)×100 for calculating the variation.  
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Fig. 5.8. The calculation of variance, mean square deviation  

and coefficient of variation 
 

To calculate quartiles one should determine the upper and lower quartiles. 

The calculation of the first quartile (Fig. 5.9) is similar to the calculation 

of the median, except for these cells: 

the cell C10 containing the formula =B9×0,25; 

the cell C18 containing the formula =C16+2×((B9×0,25-C17)/C14). 
 

 
 

Fig. 5.9. The calculation of the first quartile 
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The third quartile is in the range 11 – 13 years and is equal to 11.5. To 

define it the cell B10 contains the formula =B9×0,75, and the cell B18 

contains the formula =C16+2×((B9×0,75-C17)/C14). 

So the quartile deviation is equal to: 

 

,9.4
2

6.65.11

2

1Q-3Q
Q 

 

 

and quartile parameter of variation:  

 

%.91.52%100
26.9

90.4
%100

Me

Q
QK 

 

 

The results of calculating the total variance and its components are 

presented in Fig. 5.10. 

 

 
 

Fig. 5.10. The calculation of total variance and its components 

 

The contents of cells (Fig. 5.10) is the following:  

the cell D10 contains the formula =(B9+C9)/(5+5) for calculating the 

average volume of production at two types of ownership enterprises; 

the cell D11 contains the formula =B9/5 for calculating the average 

volume of production at the state enterprises;  
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the cell D12 contains the formula =C9/5 for calculating the average 

volume of the production at private enterprises;  

the cell D13 contains the formula =VARP(B4:B8) for calculating the 

intragroup variance (state enterprises);  

the cell D14 contains the formula =VARP(C4:C8) for calculating the 

intragroup variance (private enterprises);  

the cell D15 contains the formula =(D13×5+D14×5)/10 for calculating 

the average of the group variances;  

the cell D16 contains the formula =((POWER(D11-D10;2))×5+ 

(POWER(D12-D10;2))×5)/10 for calculating the intergroup variance;  

the cell D17 contains the formula =SUM(D15;D16) for calculating the 

the total variance. 

The variance obtained and the mean square deviation of alternative 

signs are shown in Fig. 5.11. 

 

 

 

Fig. 5.11. The calculation of the variance and mean square deviation 

 

These parameters (Fig. 5.11) were determined by means of the 

following formulas:  

the cell E7 contains the formula =(SUM(C4:C6))/SUM(B4:B6) for 

calculating the average percentage of suitable products in three 

batches; 

the cell E8 contains the formula =1-E7 for calculating the average 

percent of defective products; 
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the cell E9 contains the formula =E7×E8 for calculating the variance of 

suitable products proportion (alternative characteristics variance); 

the cell E10 contains the formula =SQRT(E9) for calculating the mean 

square deviation of alternative signs. 

The determination of the skewness and kurtosis coefficients involves 

the calculation of the moments of the third and fourth orders (Fig. 5.12). 

 

 
 

Fig. 5.12. The calculation of the skewness and kurtosis coefficients 
 

The content of the cells (see Fig. 5.12) is the following:  

the cell C11 contains the formula =(SUMPRODUCT(POWER(C3:C8-

C9;3);B3:B8))/SUM(B3:B8) for calculating the moment of  the third order; 

the cell C12 contains the formula =C11/POWER(C10;3) for calculating 

the skewness coefficient; 

the cell C13 contains the formula =(SUMPRODUCT(POWER(C3:C8-

C9;4);B3:B8))/SUM(B3:B8) for calculating the moment of the fourth order; 

the cell C14 contains the formula =(C13/POWER(C10;4))-3 for cal-

culating the kurtosis coefficient. 

 

Laboratory work No. 6 

Sampling and sampling distributions 

 

The purpose of the work is to acquire the skills of the sample survey 

with MS Excel application. 

The task is to conduct a sample survey data set by sampling, cal-

culating the maximum error and the confidence interval using MS Excel. 
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Guidelines 
 

Task 1. The enterprise is required to conduct the 10 % sampling control 

of the components, which are produced according to light alloys molding 

technology. Initial data are shown in Table 6.1. 
 

Table 6.1 
 

Background data for the sample survey 
 

Enter-

prise 

No. 

Weight 

of the 

compo-

nents 

Enter-

prise 

No. 

Weight 

of the 

compo-

nents 

Enter-

prise 

No. 

Weight 

of the 

compo-

nents 

Enter-

prise 

No. 

Weight 

of the 

compo-

nents 

Enter-

prise 

No. 

Weight 

of the 

compo-

nents 

1 16,048 11 15,989 21 16,732 31 16,154 41 16,881 

2 14,442 12 16,064 22 16,289 32 16,229 42 16,955 

3 14,747 13 16,138 23 14,659 33 16,305 43 17,030 

4 16,194 14 16,212 24 14,968 34 14,365 44 17,104 

5 15,544 15 16,287 25 16,437 35 13,485 45 17,178 

6 15,618 16 16,361 26 15,777 36 15,489 46 17,252 

7 15,692 17 16,435 27 15,852 37 15,570 47 17,327 

8 15,766 18 16,509 28 15,927 38 16,132 48 17,401 

9 15,841 19 16,584 29 16,003 39 16,694 49 16,166 

10 15,915 20 16,658 30 16,078 40 16,807 50 16,243 
 

The filled box "Sampling" of "Data Analysis" package is shown in 

Fig. 6.2. 
 

 
 

Fig. 6.2. The "Sampling" window filled by the data of the task 
 

In Input Range line one should enter the references for the range of 

data that contains the population of values you want to sample. Microsoft Excel 

draws the samples from the first column, then the second column, and so on. 
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Labels should be selected if the first row or column of your input range 

contains labels. It is clear, if your input range has no labels Excel generates 

appropriate data labels for the output table.  

Sampling Method means that you should click Periodic or Random to 

indicate the sampling interval you want.  

Period assumes the necessity to enter the periodic interval at which 

you want sampling to take place. The period-s value in the input range and 

every period-th value thereafter is copied to the output column. Sampling 

stops when the end of the input range is reached. 

In Number of Samples line you should enter the number of random 

values you want in the output column. Each value is drawn from a random 

position in the input range, and any number can be selected more than once.  

In Output Range line enter the reference for the upper-left cell of the 

output table. Data is written in a single column below the cell. If you select 

Periodic, the number of values in the output table is equal to the number of 

values in the input range, divided by the sampling rate. If you select Random, 

the number of values in the output table is equal to the number of samples.  

In New Worksheet Ply line Click is used to insert a new worksheet in 

the current workbook and paste the results starting with the cell A1 of the new 

worksheet. To name the new worksheet, type a name in the box.  

In New Workbook line create a new workbook and paste the results on 

a new worksheet in the new workbook. 

After pressing the "OK" button on your work area the result of 10 per 

cent sampling is displayed (Fig. 6.3). 

Thus we receive a sampling frame, the characteristics of which can be 

calculated by means of MS Excel, with the help of "Descriptive Statistics" of 

"Data Analysis" add-in (see the lab number No. 5). 

Besides the main characteristics of the distribution maximum sampling 

error has to be calculated. In Microsoft Excel the maximum sampling error is 

calculated by the formula: 

 

n

2
tX


 , 

where n is the number of elements in a sample population; 

  t is the confidence coefficient, which depends on the probability with 

which the maximum sampling error is guaranteed. 
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Fig. 6.3. The result of automatic random sampling 

 

Fig. 6.4 displays the calculation of sampling error limit with a 95 % 

probability. 

 

 
 

Fig. 6.4. The calculation of the limit of sampling error with a 95 % 

probability 

 

In Fig. 6.5 one can see the results of the calculations. 
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Average 15.97907 

Variance 0.813232 

n 15 

t 2 

ΔX 2.225596 

 

Fig. 6.5. The results of calculating the sampling error limit 

 

Fig. 6.6 shows the calculation and the results of calculating the 

confidence interval. 

 

Confidence interval 

lower limit =D1-D5 

upper limit =D1+D5 

 

Confidence interval 

lower limit 13.75347057 

upper limit 18.20466276 

 

Fig. 6.6. The calculation and the results of calculating  

the confidence interval 

 

Thus, according to the results one can make a conclusion deduced that 

the average for the total population with a 95 % probability belongs to the 

interval from 13.75 to 18.2. 

 

Laboratory work No. 7 

Time series analysis 

 

The purpose of the works to acquire the skills of calculating the MS 

Excel dynamics indicators. 

The tasks of the work are to use MS Excel to analyze the time series 

and to provide an economic interpretation of calculated indicators. 

 

Guidelines 

 

Task 1. We have data on the amount of investment in the sector by the 

years (Table 7.1).  
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Table 7.1 

 

The volume of investments in the sector 

 

Years 2002 2005 2006 2007 2008 2009 

The volume of investments in the 

sector, thousand UAH 
365.00 374.00 381.00 396.00 405.00 380.00 

 

It is necessary to calculate all the parameters of the dynamic series (the 

base of comparison is 2002), the average annual growth rate and accession 

rate for the following periods: 

1. 2002 – 2005. 

2. 2005 – 2009. 

3. 2002 – 2009. 

 

Let's create a file "Time series analysis". In column A and column B of 

sheet 1 the source data columns will be "Years" and "The volume of 

investments into the sector, thousand UAH" respectively.  

1. In order to calculate the growth rate: 

 enter the formula = B4-$B$3 in the cell C4. Stretch this formula to the 

entire column; 

 enter the formula = B5-B4 in the cell D5 (for 2005 it is impossible to 

calculate the absolute increase in chain manner, because there is no 

previous period – 2004) and also stretch the formula to the entire column. 

 

The results are presented in Fig. 7.1. 

 

 
 

Fig. 7.1. The results of absolute growth rates calculations 
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2. In order to define the growth rate: 

 enter the formula = B4/$B$3*100 in the cell E4. Stretch this formula to 

the entire column; 

 enter the formula = B5/B4*100 in the cell F5 (for 2005, the growth rate 

as the absolute increase, it is impossible to calculate the chain method, 

because there is no previous period, i.e. 2004) and also stretch the formula to 

the entire column. 

3. To define the 1 % accession rate: 

 enter the formula = E4-100 in the cell G4. Stretch this formula to the 

entire column; 

 enter the formula = F5-100 in the cell H5 and also stretch the formula 

to the entire column. 

4. To define the absolute value of 1 % of the increase: 

enter the formula = B4/100 in the cell I5. Stretch this formula to the 

entire column. 

The calculation results are given in Fig. 7.2. 

 

 
 

Fig. 7.2. The results of growth rate and accession rate calculations 

 

5. Let's define the average dynamics parameters. 

5.1. The average level of the series is determined in the following way. 

Since we have a number of missed levels it is expedient to calculate the 

average level of series for the period of 2005 – 2009, i.e. to select the built-in 

aggregate function AVERAGE in the cell B10. 

5.2. For calculating the average absolute growth  rate enter the formula 

= (B8-B3) / 8 in the cell B11. 

5.3. The average growth rate is calculated as follows: 

1. For 2002 – 2005 one should enter the formula = (B4/B3)^(1/3) in the 

cell B14. 
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2. For 2005 – 2009: 

the basic method is to enter the formula = (B8/B4)^(1/4) in the cell B16; 

the chain method is to enter the formula = ((F5/100) x (F6/100) x  

x (F7/100) x (F8/100))^(1/4) in the cell B17; 

3. For 2002 – 2009: 

the basic method is to enter the formula = (B8/B3)^(1/7) in the cell B19; 

the chain method of weighted geometric mean formula is to enter the 

formula = ((B14) 3 x (B16) 4)^(1/7) in the cell B20. 

5.4. The average accession rate is calculated in the following way: 

1. For 2002 – 2005:  

one should enter the formula C14 = (B14-1) x 100 into the cell; 

2. For 2005 – 2009: 

one should enter the formula = (B16-1) x 100 into the cell C16; 

3. For 2002 – 2009:  

one should enter the formula = (B20-1) x 100 into the cell C20. 

The results of the calculations of the average values are shown in 

Fig. 7.3. 

 

 
 

Fig. 7.3. The results of determining the average dynamics 

 

Thus, during the period of 2002 – 2008 a steady growth in investment 

was observed, but in 2009 the volume of investments decreased in com-

parison with 2008 by 25 thousand UAH (compared to 2002 it increased by 15 

thousand UAH). The growth rate in 2009, calculated of the basic method was 

104.11 %, i.e. the increase in output was 4.11 %. The chain accession rate 

showed a decrease in the volume of production in comparison with 2008 by 

6.17 %. 1 % growth rate in 2009 was equal to 405 UAH. In the period of 2002 – 
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2009, the investment increased annually by an average of 1,875 UAH, i.e. 

0.58 %. The average investment for the period of 2005 – 2009 was 387.2 

thousand UAH. In the period from 2002 to 2005 the investment was growing at 

an average by 0.82 %, from 2005 to 2009 by – 0.4 %. 

 

Laboratory work No. 8 

The index method 
 

The purpose of the work is to acquire the skills of statistical data 

analysis by means of the index method in the MS Excel package. 

Its task is to analyze the data by the index method using MS Excel. 
 

Guidelines 
 

Task 1 
 

We have data on the sales of products (Table 8.1). 

 

Table 8.1 
 

Data on the sales of products 

 

Production The base period The reporting period 

The quantity of 

products, items 

Price per unit, 

UAH 

The quantity of 

products, items 

Price per unit, 

UAH 

А 350 200 420 225 

B 170 120 110 150 

 

On the basis of these data is necessary to determine: the total turnover 

index, the overall price index, a general index of the physical volume of trade, 

the absolute amount of savings or cost overruns on price changes. Draw a 

conclusion. 

To determine the overall index of turnover enter the formula = D3xE3 

into the cell F3 and stretch the formula to the whole column, calculate the 

amount of the column in the cell F5, either by clicking the sign Σ AutoSum 

button on the toolbar, or by pressing the "=" and selecting the SUM formula in 

a formula row, then enter the formula = B3 x C3 into the cell G3 and stretch 

the formula to the whole column and calculate the amount in the cell G5 

(Fig. 8.1). 
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Fig. 8.1. The calculation of the total turnover index 

 

To obtain the final result enter the formula = F5/G5 into the cell H5. The 

overall turnover index is equal to 1.23, or 123 %, that is, turnover in the 

current period increased by 23 % compared to the reference period due to 

the changes in product prices, and also due to the changes in the number of 

products sold. 

To determine the general price index enter the formula = D3 x E3 into 

the cell F3 and stretch the formula to the whole column, calculate the amount 

of the column in the cell F5, either by clicking the sign Σ AutoSum button on 

the toolbar, or by pressing the "=" and selecting the SUM formula in a formula 

row, enter the formula = D3 x C3 into the cell G3 and stretch the formula to 

the whole column, calculate the sum in the cell G5.  

To get the value of the general price index enter the formula = F5/G5 

into the cell H5 (Fig. 8.2). 

 

 
 

Fig. 8.2. The calculation of the general price index 

 

The overall price index is equal to 1.14, or 114 %, that is, turnover 

increased by 14 % in the current period compared to a turnover in the base 

period, due to the changes in product prices at a constant output. 
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The absolute amount of cost overrun or savings from the price changes 

is calculated as the difference between the numerator and denominator of the 

price index by the formula = F5-G5 entered into the cell H5 (Fig. 8.3). 

 

 
 

Fig. 8.3. The calculation of the absolute amount of cost overrun  

or savings from the price changes 

 

The absolute amount of overrun due to the price changes in the re-

porting period compared with the base one was 13,800 UAH. 

To determine the total volume index of turnover enter the formula  

= D3xC3 into the cell F3 and stretch the formula to the whole column, 

calculate the amount of the column in the cell F5, either by clicking the sign  

Σ AutoSum button on the toolbar, or by pressing the "=" and selecting the 

SUM formula in the formula bar, enter the formula = B3xC3 into the cell G3 

and stretch the formula to the whole column, then in the cell G5 calculate the 

sum. To get the value of the overall index of physical volume of trade enter 

the formula = F5/G5 into the cell H5 (Fig. 8.4). 

The overall index of the physical volume of trade is equal to 1.08, or 

108 %, that is, turnover increased by 8 % in the current period, compared 

with a turnover in the base period, due to the changes in the physical volume 

of sales at a fixed price. 

 

 
 

Fig. 8.4. The calculation of general index of physical volume  

of commodity turnover 
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Task 2 

 

We have the data on the costs of production and changes in the cost of 

the enterprise (presented in Table 8.2). 

 

Table 8.2 

 

Characteristics of the production in view of the product range 

 

Product name The cost of production in 

the 2nd quarter, thousand 

UAH 

Changing the unit cost of the product 

in the 2nd quarter compared to the 1st 

quarter,% 

А 1,850 +18 

B 670 +11 

C 755  No change 

 

Identify the common indices of: 1) the prime cost, 2) the volume of 

production, and 3) the cost of production, provided that the cost of production 

in the 2nd quarter compared to the 1st quarter increased by 27 %. Draw the 

conclusions. 

In the cell D2 the prime  cost index is calculated individually using the 

formula = (C2 100/100), in the second column (the cost of production in the 

2nd quarter, thousand UAH) the amount is calculated by clicking the 

AutoSum Σ sign on the toolbar after selecting the entire column. Enter the 

formula = B2/D2 into the cell E3, calculate the amount of the column in the 

cell E5, either by clicking the sign Σ AutoSum button on the toolbar, or by 

pressing the "=" and selecting the SUM formula in the formula bar. To get the 

value of the total cost of the index enter the formula = B5/E5 into the cell F5 

(Fig. 8.5). 
 

 
 

Fig. 8.5. The calculation of the total cost index 
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The total prime cost index is equal to 1.12, or 112 %, i.e. the total cost 

of production increased by 12 % in the reporting period compared to the 

overall cost base, by increasing the cost and at constant output. 

Based on the conditions of the task, the overall cost index (Izq) is 1.27 or 

127 %, as the cost of production in the second quarter compared with the first 

increase by 27 % due to the changes in the cost and volume of output. For 

the calculation of the overall index of production using the relationship 

between the indexes enter the formula = G5/F5 into the cell H5 (Fig. 8.6). 

 

 

 

Fig. 8.6. The calculation of the overall index of production 

 

Total production expenses increased by 13 % due to the changes in the 

volume of production at a fixed cost. 

 

Task 3 

 

We have data on the production of products of the same name "A" and 

its cost at two plants (Table 8.3). 

 

Table 8.3 

 

Data on production and production prime cost 

 

Plant Production, thousand units The unit cost of production, UAH 

year year 

2007 2008 2007 2008 

1 90 100 210 205 

2 180 110 180 240 
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Determine the cost indices: variable composition, constant composition, 

structural changes. Explain the difference between these indices. 

To determine the index of the cost of variable composition enter the 

formula = E5xC5 into the cell F5 and stretch the formula to the whole column, 

calculates the amount of the column in the cell F7, either by clicking the sign 

Σ AutoSum button on the toolbar, or by pressing the "=" and selecting the 

SUM formula in the formula bar, enter the formula = F7/S7 into the cell G7 to 

get the value of the first fraction, enter the formula = D5xC5 into the cell H5 

and stretch the formula to the whole column, count the amount by the column 

in the cell H7, either by clicking the sign Σ AutoSum button on the toolbar, or 

pressing the "=" and selecting the SUM formula in the formula bar, enter the 

formula = H7/S7 into the cell I7 to get the value of the second fraction. 

To get the index value of the variable cost enter the formula = G7/I7 into 

the cell J7 (Fig. 8.7). 

 

 
 

Fig. 8.7. The calculation of the index of the prime cost of variable 

composition 

 

To get the index of the prime cost of variable composition enter the 

formula = G7/I7 into the cell J7 (Fig. 8.7). 

The index of the prime cost of variable composition was 1.15 (115 %), 

the average unit cost of production increased by 15 % due to the changes in 

the cost and quantity of output. 

To determine the index of the prime cost of the fixed structure enter the 

formula = E4xC4 into the cell F4 and stretch the formula to the whole column, 

calculate the amount of the column in the cell F6, either by clicking the sign Σ 

AutoSum button on the toolbar, or by pressing the "=" and selecting the SUM 

formula in the formula bar, enter the formula = F6/S6 into the cell G6 and get 

the value of the first fraction, enter the formula = B4xD4 into the cell H4 and 

stretch the formula to the whole column, calculate the amount in the column 

of the cell H6, either by clicking the sign Σ AutoSum button on the toolbar, or 

pressing the "=" and selecting the SUM formula in the formula bar, enter the 

formula = H6/B6 into the cell I6 and get the value of the second fraction. 
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Fig. 8.8. The calculation of the index of the prime cost of the fixed 

structure 

 

To get the index of the cost of fixed composition enter the formula  

= G6/I6 into the cell J6 (Fig. 8.8). 

The index of the cost of fixed composition was 1.18 (118 %), that is, the 

average cost of production increased by 18 % due to the changes in unit 

costs at constant amount of output. 

To determine the index of the cost of structural changes enter the 

formula = D4xC4 into the cell F4 and stretch the formula to the whole column, 

calculate the amount of the column in the cell F6, either by clicking the sign Σ 

AutoSum button on the toolbar, or by pressing the "=" and selecting the SUM 

formula in the formula bar, enter the formula = F6xC6 into the cell G6 to 

obtain the value of the first fraction, enter the formula = B4xD4 into the cell 

H4 and stretch the formula to the whole column, calculate the amount for the 

column in the cell H6, either by clicking the sign Σ AutoSum button on the 

toolbar, or pressing the "=" and selecting the SUM formula in the formula bar, 

enter the formula = H6/B6 into the cell I6 and get the value of the second 

fraction. 

To get the index of the cost of structural changes enter the formula  

= G6/I6 into the cell J6 (Fig. 8.9). 

 

 
 

Fig. 8.9. The calculation of the index of the cost of structural changes 

 

The index of the cost of structural change was 1.02 (102 %), that is, the 

average cost of production increased by 2 % due to the changes in the 

number of output at constant unit costs. 
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